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Air Composition
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Air quality monitoring: pollutants and GHG

Problem statement

Particle pollution:
Particulate matter (PM)

Mixture of solid particles and liquid

droplets found in the air. Some

particles, such as dust, dirt, soot, or

smoke, are large or dark enough to

be seen with the naked eye.

PM 10: diameter lower than 10 um

PM 2.5: diameter lower than 2.5 um

Effect on body: group 1 carcinogen

Gaseous pollutants
Gas molecules (chemical

species) that may lead to

adverse health effects for

humans.

NO2, NO, NH3, CO, BTX, SO2, O3,
VOCs
Toxic concentration: ppm, ppb

Sources: human activities or

natural phenomena

Effect on body: cardiovascular
disease, stroke, lung disease

Greenhouse gases
Gases that trap heat in the

atmosphere and warm the

planet!

How much any one

greenhouse gas influences

global warming depends on:

- Concentration (ppm, ppb or

ppt)

- Lifetime

- Global Warming Potential

(GWP)

CO2, CH4, N2O, halocarbons



Enviromental protection agency 
Monitoring Network
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PM10 and PM2,5

O3

SO2

NOx NO NO2

https://www.appa.provincia.tn.it/

https://www.appa.provincia.tn.it/
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Particulate Matter: 
Aerodynamic Diameter

Establishing a particle size definition for irregularly shaped particles necessitates the use of a standardized measure

referred to as the aerodynamic diameter, measured in microns or micrometers (μm), a unit equal to one millionth of a

meter. The graph at the right shows the distribution of the 4 main particle size categories, with the categories historically

and currently regulated by EPA indicated below. By comparison, a human hair is approximately 70 microns in diameter.
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What is Particulate Matter?
Particulate matter (PM) describes a wide variety of airborne material.

PM pollution consists of materials (including dust, smoke, and soot),

that are directly emitted into the air or result from the transformation

of gaseous pollutants. Particles come from natural sources (e.g.,

volcanic eruptions) and human activities such as burning fossil fuels,

incinerating wastes, and smelting metals.

Where does PM originate?

Sources may emit PM directly into the environment or emit precursors such as
sulfur dioxide (SO2), nitrogen dioxide (NO2), and volatile organic compounds

(VOCs), which are transformed through atmospheric chemistry to form PM.

Mobile Sources

(vehicles)
VOCs, NO2, PM

Stationary Sources 

(factories)
NO2, SO2, PM 

Area Sources

(drycleaners, gas stations)
VOCs

Natural Sources 

(forest fires, volcanoes)
PM 
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Particulate:

UNI EN 12341:2014 “Ambient air - Standard gravimetric measurement

method for the determination of the PM10 or PM2,5 mass concentration of

suspended particulate matter”
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Laser-based optical particulate sensor
Measurement principle

This measurement principle is based on laser light scattering. Airflow is generated inside the sensor with the aid of a fan. This airflow carries

particulate matter in the ambient air from the inlet of the sensor to the outlet. Near the photodiode, the particles in the airflow pass through a

focused laser beam, scattering the laser’s light. A photodiode converts this scattered light into an electrical signal, which is then converted on

the internal microcontroller into an output value for the matter’s mass and concentration using algorithms.

• British physicist

• known especially for the 
Rayleight scattering in 1871.

John William Strutt, 3rd Baron Rayleigh
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Gases
In the last decades, pollutant gases have been strongly decreased in the atmosphere. However, some of them still 

exceed the limitations recommended by policy makers, including in EU. 

NO2 O3

Greenhouse gases: CO2NH3

BTX  (benzene, toluene, ethylbenzene and xylene)
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EU air quality map

https://airindex.eea.europa.eu/Map/AQI/Viewer/

https://airindex.eea.europa.eu/Map/AQI/Viewer/
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The electromagnetic (EM) spectrum is the range of all
types of EM radiation. Radiation is energy that travels
and spreads out as it goes – the visible light that comes
from a lamp in your house and the radio waves that
come from a radio station are two types of
electromagnetic radiation. The other types of EM
radiation that make up the electromagnetic spectrum
are microwaves, infrared light, ultraviolet light, X-
rays and gamma-rays.

Electromagnetic spectrum

€
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What may happen when light strikes an object? 

1. All wavelengths of the light may be entirely reflected from 

the surface, which would result in what we perceive as the 

“color” white. 

2. All wavelengths may be entirely absorbed by the object, 

which would result in what we perceive as the “color” black. 

3. The light may be completely transmitted through the 

object, with little interaction, resulting in what we call a 

colorless object. Glass is an example of this.

4. Some wavelengths can be reflected and others absorbed, 

resulting in the appearance of the different colors.

Light – Matter interaction
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Chemilumiscence

Chemiluminescence refers to light which is emitted after excitation of a molecule during a chemical reaction. It is being used in the 
analysis of nitrogen gases.
Nitrogen monoxide reacts with ozone to excited nitrogen dioxide.

NO + O3 → NO2* + O2

NO2* → NO2 + hν (luminescence)
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Symmetric 
Stretch Vibration

Anti-symmetric 
Stretch Vibration

Deformation
Vibration

• IR light interacts with the sample molecules (e.g. water).

• Depending on its energy, IR radiation can trigger the vibration of specific molecular bonds (absorbtion).

Light – Matter interaction
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NDIR
Working principle

• IR fingerprint of gas molecules

Absorption spectra for five gases in the mid IR region of the spectrum (all at 100% vol), taken from the

PNNL database, from Optical gas sensing: a review; Jane Hodgkinson and Ralph P Tatam 2013 Meas.

Sci. Technol. 24 012004 doi:10.1088/0957-0233/24/1/012004
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Monitoring Pollutants from the space
Copernicus EU programme

https://maps.s5p-pal.com/no2/

Sentinel-5P provides timely data on a multitude of trace

gases that can affect our health such as nitrogen

dioxide and carbon monoxide. It will also measure

sulphur dioxide, which mainly comes from industrial

processes and motor vehicle emissions, but can also be

in volcanic plumes.

What sets Tropomi apart is that it measures in the

ultraviolet and visible (270–500 nm), near-infrared

(675–775 nm) and shortwave infrared (2305–2385 nm)

spectral bands. This means that a wide range of

pollutants such as nitrogen dioxide, ozone,

formaldehyde, sulphur dioxide, methane and carbon

monoxide can be imaged more accurately than ever

before. With a resolution as high as 7 km × 3.5 km, it has

the potential to detect air pollution over individual cities.

Only Stratospheric Ozone

https://maps.s5p-pal.com/no2/


page
017

Pros and Cons

1. Accuracy: Extreme precision and repeatability of the measure

2. Calibration: Periodic calibration must be done on all sensor types. However, on laboratory units, as long as the

zero is maintained, the unit is assured a good response and good span accuracy. Because of this characteristic,

abnormal functioning of a unit can be easily determined.

3. Life Expectancy: A well-designed unit has a life expectancy of more than 10 years.

4. Continuous Exposure to Gas: The functional components are protected by the optical parts, which are basically

inert to most chemicals.

BUT EXPENSIVE

(10-20k€)
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters
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Problem statement

Composition of air
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Air quality monitoring: physical dimensions

Problem statement

Typical concentrations at which a pollutant begins to be harmful to humans: part per million by volume
(ppmv) – part per billion by volume (ppbv)

Standard units of measurement used by EPA = mg/m3 and µg/m3

Conversion

M = molecular mass
T = air temperature (K)

Example
Carbon monoxide (CO)

M(CO) =  28.01 g/mol
T = 298 K

1 ppmv (CO) = 1.15 mg/m3

EU policy
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Perchè investigare sensori di gas innovativi?

Greenhouse gases:
CO2, O3, CH4, N2O, 

fluorocarburi 

Pollutant gases:
NO2, NO, NH3, CO, 

SO2, BTX, SO2

High costs

Premature 
deaths

Problem statement
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Perchè investigare sensori di gas innovativi?

Based on radiation-matter
interaction Vantaggi

- Alta sensibilità

- Alta selettività

Svantaggi
- Ingombranti

- Alto costo (10-30 K€)

- Lavorano a T e umidità

specifiche

Certified monitoring tools

FT-IR

Chemiluminescenza

7 monitoring 
stations

Only few 

monitoring 

stations can be 

deployed

=

Low spatial-time 

resolution on the 

data collected

Inquinamento ambientale



Why gas sensors?

Problem statement

Resolution 13/3/2019: EU calls on the Commission and the Member States to support research, development and certification at
EU level for innovative smart multi-sensor systems for air quality monitoring. Smart air quality monitoring systems can be a viable
tool for citizen science, and also of special benefit for people suffering from asthma and cardiovascular diseases

Lack of high-performing, low cost and portable sensing platform

Solid state gas sensors

Thermometric Optical gas sensors

Quartz microbalance Electrochemical

• High stability

• Low cost

• High durability

• Low selectivity

• Low sensitivity

• High power consumption

• High selectivity

• High sensitivity

• Expensive

• Bulky

• High sensitivity

• Low cost

• Low power consumption

• Low selectivity

• Low durability

• Low stability

• High stability

• High sensitivity

• Suitable for MF

• Low cost

• Low selectivity

• High power 

consumption
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters



Receptor-Transducer mechanism in a chemical sensor

Low cost gas sensors

• Receptor:

“The chemical information is transformed, by the sensor into a

form of energy, which may be measured by the transducer”

• Transducer:

“Transforms the energy carrying the chemical information

about the sample into a useful analytical signal.”

“The transducer as such does not work as a sensor”

• Separator: can be included in a sensor,

e.g. a membrane

Receptor

Transducer

Separator
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Receptor-Transducer mechanism in a chemical sensor

Low cost gas sensors
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Physisorption = only involves physical interactions between 
analyte and sensing layer)
Chemisorption = involves a chemical reaction between the 
surface and the analyte

The receptor is usually a reactive material

The reaction occurring between sensing material and 
analyte (gas) is transform into a readable electrical signal
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters
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Chemoresistive Gas Sensors

Detection of low gas concentrations through a change of resistance in nanostructured semiconducting
materials in thermal- or photo-activation mode.

Receptor                              Transducer

• The chemoresistive gas sensors are used in different
applications:
Ø control units for the indoor/outdoor air quality monitoring;
Ø analysis and diagnosis of clinical disease with non-

invasive methods.

Advantages

• High thermal stability
• Easy to synthesize in 

nanometric scale
• Reversible surface 

reaction in 
temperature

• Excellent sensitivity
• Fast response and 

recovery
• Small dimensions and 

simple integration in 
IoT platforms

• Low costs of 
manufacturing

The materials most widely used so far are the MOX semiconductors

Chemoresistive gas sensors
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Chemoresistive Gas Sensors: 

Main Components

Sensing Material => Receptor and Transducer of the Surface Chemical Reaction

Chemoresistive gas sensors

Substrate => Triple Role: Mechanical Support, hosts Heater and Electrodes for the sensing 
material signal read-out
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters
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What is a semiconductor?

Chemoresistive gas sensors

Band gap: distance between the 
valence band of electrons and the 
conduction band. 
Essentially, the band gap 
represents the minimum energy 
that is required to excite an 
electron up to a state in the 
conduction band where it can 
participate in conduction

Conductors: allow the current flow due to the presence of free electron or ions which starts moving when voltage is applied.

Semiconductor: a material whose conductivity lies between conductor and insulator. Energy must be apply in order to push 
electrons from the valence to the conduction band, increasing the material conductivity

Insulator: a material that does not allow the flow of current.



What is a semiconductor?

FBK gas sensors group

The sensing material is a nanostructured semiconductor, so
it needs to be ACTIVATED to work properly

Basic materials for the development of modern-day technologies!
Silicon = basic material for microchips

The electrical conduction inside semiconductors is due to the movement of 
electrons and holes

n-type semiconductors: charge carriers = electrons
p-type semicoductors: charge carriers = holes
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What is a nanostructured material?

Nanomaterial: material composed of particles consisting of atomic or molecular
aggregates with a diameter of approximately 1 to 100 nm

Produced and used for nanotechnology development

Advantages:
1) Very high surface area-to-volume 

ratio
2) Different chemical and physical 

properties compared with macro-
material

Chemoresistive gas sensors



page
017

Sensing materials

Sensing material

The most widely used semiconductors as sensing materials are METAL OXIDES (MOX) = metal + oxygen
• Wide range of choices (SnO2, WO3, ZnO, TiO2, etc.). 
• Simple and low-cost syntheses

Advantages in using as a sensitive material:
• High sensitivity

• High thermal stability
• Reversible surface reactions in activation

• Fast responses to the presence of gases

Chemoresistive properties can be activated by:
• Heating = thermo- activation
• Electromagnetic radiation (light) = photo-

activation
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Sensing material

Nanostructured MOX: Synthesis

Synthesis process
Ø Solvent effect (PEG, alfa-terpineol)
Ø Reagents (metal-organics)
Ø pH control 
Ø Complexing agent

Heat treatments
Ø Temperature
Ø Timing
Ø Atmosphere

Ullattil S.G., Periyat P. (2017) doi:10.1007/978-3-319-50144-4_9

High control of 
morphology and 
crystal structure
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters



Substrate
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Substrate

Triple Role: Mechanical Support, hosts Heater and Electrodes for the sensing material signal read-out

Optimization of the substrate over the 
time:
1) Decrease of power consumption
2) Size decrease

Integration into portable devices
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Substrate: silicon microheater

Microheater: top view 
(3x3 mm2)

6“ silicon wafer:
1350 microheaters

Heater: Pt, 
heating 

through Joule 
heating effect

Microheater:
Cross section

Elettrodes: 
read-out of the 
sensing 
material 
resistance

Process used: Silicon microfabrication

Substrate
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Sensing material

Joule heating

Joule heating, also known as resistive, resistance, or Ohmic heating, is the process by which the 
passage of an electric current through a conductor produces heat.

Joule's first law states that the power of heating generated by an electrical conductor equals the 
product of its resistance and the square of the current:

P = I2 * R

Why?: A potential difference (V) between two points of a conductor creates an electric field that
accelerates charge carriers (e.g. e-) in the direction of the electric field, giving them kinetic energy.
When the charged particles collide with the conductor lattice, energy is being transferred from them to
the material!
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OUTLINE

FBK sensor group & 
problem statement

Low cost gas sensors

Chemoresistive gas 
sensors: working principle

Sensing materials

Substrates

Working principle and 
influencing parameters
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Sensor production @ FBK

Microfabrication process of silicon MH

Sol gel synthesis of nanostructured MOX,
MOX decoration, preparation of other semiconductors

Sensing material deposition
Ball bonding and 

Packaging

Gas sensors @ FBK
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MOX Chemoresistive gas sensors: Gas – Surface Interaction

Chemoresistive gas sensors
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Agenda

• Chemoresistive sensors
• Electronics for sensors readout
• Hands-on with ST Nucleo

2



Chemoresistive sensor, 
mounted on a TO package

3



That’s like a commercial 
sensor

4



What’s inside:

Electronics to power, read
and interface

5

Sensor element
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Technology

1 Sensing material
It’s a MOX nano-structured 
paste, interact with specific 
types of gas

2 Substrate
Mechanical support, heater and 
electrical circuit



Sensor – pysical
characteristics

We built a lot of different sensors, every one has different characteristics
- LaFeO3  → <100 kOhm
- STN → >100 MOhm
- WO3 → ~10 Mohm

It varies with temperature!
And gas concentration, clearly.

We are going to measure its resistance

7



Heater – pysical
characteristics

Again, we have different layout of the silicon, that are designed for different
temperature setpoints, usually characterized at the wafer level

Electronics must find a sweet spot where the sensor should operate:
The membrane is fragile, can break with thermal shock or overtemperature

Usually 80-120 Ohm at 3.5-4.5 V → max 200mW

8
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Heater
It is powered by a dedicated circuit, heat up the sensor at the right temperature. On the 
board is available a DAC that can be used to this purpose.

MOx sensible layer
Thanks to a 1.024 V reference, it is possible to measure the resistance of the sensor. The 
current flowing in the sensor is amplified and read by an ADC.

Sensor



Electronics



What electronics do

1. Measure a low current (or high resistance)
2. Supply variable voltage at the heater
3. Measure resistance at the heater side
4. Multiply it for different channels (2 in our case)
5. Processing and communication…

11



ADC and DAC

In electronics, an analog-to-digital
converter (ADC, A/D, or A-to-D) is
a system that converts an analog
signal, such as a sound picked up
by a microphone or light entering
a digital camera, into a digital
signal.

https://en.wikipedia.org/wiki/Analog-to-digital_converter

In electronics, a digital-to-analog
converter (DAC, D/A, D2A, or D-
to-A) is a system that converts
a digital signal into an analog
signal. An analog-to-digital
converter (ADC) performs the
reverse function.
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https://en.wikipedia.org/wiki/Electronics
https://en.wikipedia.org/wiki/Analog_signal
https://en.wikipedia.org/wiki/Microphone
https://en.wikipedia.org/wiki/Digital_camera
https://en.wikipedia.org/wiki/Digital_signal_(signal_processing)
https://en.wikipedia.org/wiki/Analog-to-digital_converter
https://en.wikipedia.org/wiki/Electronics
https://en.wikipedia.org/wiki/Digital_signal_(signal_processing)
https://en.wikipedia.org/wiki/Analog_signal
https://en.wikipedia.org/wiki/Analog-to-digital_converter


Arduino
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Development board

STMicroelectronics  Nucleo-F401

STM32F401RE
32-bit Cortex®-M4 CPU with FPU
frequency up to 84 MHz
512 Kbytes of Flash memory

USB connection and debugger 
on-board

Arduino friendly!

14



Readout 
Electronics

DAC and driving
circuit

15

Sensors

Amplifier

ADC

STM32 nucleo



Circuit
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Arduino setup
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Install Arduino

https://www.arduino.cc/en/software

https://www.arduino.cc/en/software
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Arduino for ST Nucleo:
add source URL

Add source for 
STMicroelectronics boards, so 
that you will be able to install 
the tools
- File → Preferences
- Add stm32duino URL 
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Arduino for ST Nucleo:
install the toolchain

Add the boards needed, i.e. 
STM32 based boards
- Tools → Board → Board 

Manager
- Select Contributed
- Install STM32 MCU based 

boards
- Arduino will install the tools 

needed to work with such 
boards. 
It might take a while…
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Arduino for ST Nucleo:
select the right board
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Hello World!

void setup() {
// initialize digital pin LED_BUILTIN as an output.
pinMode(LED_BUILTIN, OUTPUT);

}

// the loop function runs over and over again forever
void loop() {

digitalWrite(LED_BUILTIN, HIGH);
delay(1000); // wait for a second
digitalWrite(LED_BUILTIN, LOW);
delay(1000); // wait for a second

}
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Codebase 

https://gitlab.fbk.eu/ptosato/inspyre23

https://gitlab.fbk.eu/ptosato/inspyre23


Back to the HW



Circuits, again!
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Circuits, again!

MCP4716 (x2)

MCP3428
(x2 channels)

MCP3428
(x2 channels)

Arduino 
AnalogIn

(x2 
channels)

200x

2x
𝑅 = 0.3Ω

??

1.66x

26



Measure the resistance

𝑉 = 𝐼𝑅
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𝑉𝐴𝐷𝐶 = 𝐼𝑠𝑒𝑛𝑠𝑜𝑟𝑅𝐹𝐵

𝑅𝑠𝑒𝑛𝑠𝑜𝑟 =
𝑅𝐹𝐵 𝑉𝑟𝑒𝑓
𝑉𝐴𝐷𝐶

𝑉𝑟𝑒𝑓 = 1.024 𝑉

𝑅𝐹𝐵 = 1 𝑘Ω, 1 MΩ



Code setup

MCP3428 (ADC)
Datasheet: https://bit.ly/3a6C7ob

MCP4716 (DAC)
Datasheet: https://bit.ly/3LVJZ9m

28

https://bit.ly/3a6C7ob
https://bit.ly/3LVJZ9m


Channel
This chip has 4 channels

Resolution
Number of bits used by the digitizer, 
should use 16 bits

Gain
An internal amplifier can further 
amplify the signal (1 to 8x)

29

MCP3428



30

Code for MCP3428

Select Tools → Library 
Manager to search for 
additional libraries.

After installation you can 
find some examples ready 
to be used.
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Code for MCP3428

const float adc_res = 62.5E-6;
long value = 0;
MCP342x::Config status;
MCP342x::Gain gain = MCP342x::gain1;

// read heater current - channel 1
uint8_t err = adc.convertAndRead(MCP342x::channel4, MCP342x::oneShot,

MCP342x::resolution16, gain, 1000000, value, status);

lsb = adc_res / 1;
float htr1_i = value * lsb / 0.3 / 200;

// read sensor - channel 1
gain = MCP342x::gain8;
err = adc.convertAndRead(MCP342x::channel1, MCP342x::oneShot,

MCP342x::resolution16, gain, 1000000, value, status);

lsb = adc_res / 8;
sensor_raw = value*lsb;
float sen1_r = ...



Channel
This chip has only one channel, but 
there are two on the board.

Resolution
Only 10 bits, but more than enough

Gain
There is an internal amplifier, but we 
use the external one that is more 
capable
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MCP4716
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Code for MCP4716

There is no library in the 
Library Manager, so we may
ask Google for that.

In this case you can 
download the code from 
GitHub and paste it in the 
folder where you have your
Arduino code.
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Code for MCP4716

𝐿𝑆𝐵 =
3.3
1023

= 0.0032 𝑉uint8_t address_DAC1 = 0x63;
uint8_t address_DAC2 = 0x61;

MCP4716 dac1 = MCP4716(address_DAC1);
MCP4716 dac2 = MCP4716(address_DAC2);

uint16_t dacOut1 = 50; // 160mV -> around 320mV on the heater
uint16_t dacOut2 = 100; // 320mV -> 650mV

dac1.setVout(dacOut1);
dac2.setVout(dacOut2);



Other constants and 
connections

Signal Arduino 
Port

LED1 D11
LED2 D12
EN D9
Heater voltage (channel 1) A4
Heater voltage (channel 2) A5
SW (channel 1) D10
SW (channel 2) D8

Signal MCP3428 
channel

Heater current (channel 1) 4
Heater current (channel 2) 3
Sensor resistance (channel 1) 1

Sensor resistance (channel 2) 2
Resistance SW value
1 kOhm HIGH
1MOhm LOW
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